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OTDR Basic Operation 

The Optical Time Domain Reflectometer (OTDR) is an instrument that uses the inherent backscattering 
properties of an optical fiber to detect faults and categorize its condition. The OTDR sends high-power 
pulses of laser light down the fiber and captures the light that is reflected back (much like a radar system). 
By measuring the timing and power levels of the return pulses, the instrument correlates the reflected 
information with physical locations along the fiber and displays a “trace” that shows optical power versus 
distance. Attenuation of the fiber is displayed as the slope of the trace. Interruptions such as splices, 
connectors, bends, breaks or flaws in the fiber appear as transitions (“events”) that represent their nature 
and location. 
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Dynamic Range 

The measure of a system’s 
ability to distinguish signals 
in the presence of noise. 
Several definitions exist for 
OTDR dynamic range. 
Bellcore defines the 
dynamic range as the 
displayed attenuation (in 
dB) from the backscatter 
level at the front panel to an 
imaginary line (past the end 
of the fiber)that lies just 
above 98% of the noise. 
Another common definition 
(based on Signal-to-noise 
ratio = 1) uses an imaginary 
line that lies just above 
roughly 63% of the noise. 



Attenuation Deadzone 

The minimum distance after a 
reflective event before the 
OTDR can accurately measure 
the loss of a non-reflective 
event. Typically, the 
attenuation  dead zone is the 
distance from the leading edge 
of the reflection to the point 
past the reflection where the 
OTDR signal level returns to 
within 0.5 dB of the 
backscatter level. 

 



Event Deadzone 

The minimum distance after a 
reflection before the OTDR 
can accurately measure the 
distance to a second 
reflection, sometimes called 
the “two point spatial 
resolution.” The event dead 
zone is measured from the 
leading edge of the reflection 
to the point past the reflection 
where the level of the OTDR 
signal drops at least 1.5 dB 
from the top of the reflection. 

 



920XC Product Overview 

Features 
•  Easy to Use/Compact Handheld Design 

•  Automated Measurement/Analysis/File Save 

•  38dB Dynamic Range 

•  1.5 meter event deadzone 

•  Large color LCD display 

•  Measure length and defects of coiled fiber 

•  RS-232 and USB interface 

•  Store 1000 measurement results 

•  NiMH battery for 8 hours continuous use 

•  Internal VFL (650nm) 



920XC Measurements 

Measurement Application 

•  The 920XC instruments display power relating to the distance of returning signals. This 
information can be used to identify the main properties of an optical fiber chain. 

 Measurement Contents 

•  Event location (distance), end, or rupture of optical fiber chain. 

•  Attenuation coefficient of fiber. 

•  Loss of a single event (for example, one optic tie-in), or total loss from upper end to end. 

•  Range of a single event like reflection of connectors (or grade of reflection). 

•  Auto measurement of cumulative loss of a single event. 

Trace Analysis 

•  The trace analysis of the 920XC OTDR is fully automatic. The trace locates: 

•  Reflection events of connections and mechanical tie-ins. 

•  Non-reflection events. 

•  End of optical fiber. 

•  Through scanning the first loss event that is larger than the end threshold, identifies the end of 
optical fiber. 

•  Events list: Event type, loss, reflection, and distance. 



920XC  -  Ports and Indicators 

1. Charge Indicator: When lit, measurement 
power is charging. 

2. Power Indicator: When lit, measurement 
power is on. 

3. AC Power Jack: Power adapter jack 
requirements are 13.8 VDC at 1.2 A. 

4. Data Transfer Ports: USB and RS-232 
interfaces to transfer saved traces in the 
instrument to a PC for further analysis 
with Trace Viewer software (provided). 

5. Fiber Optic Output for OTDR and VLS 
(visual fault locator): The VLS Connector 
is used for the OTDR interface at 1625nm. 

6. Invisible Laser Caution: Do not look 
directly at the optical output or stare at the 
laser beam. 



Keypad Definitions 

1. On/Off:  

• Press to turn power on or off to the instrument. 

2. Run/Stop: 

•   Under GUI, press to start measurement. 

•   While testing, press to stop measurement. 

3. Enter: 

•   Under GUI, press to confirm the current operation. 

•   Use with the Shift key to browse down the events 
list. 

4.  (up and down) arrows: 

•   Move menu bar in menu operation. 

•   Highlight the icon to be selected. 

•   Adjust parameter in parameter configuration. 

•   Use with the Shift key to zoom out or zoom in 
trace vertically. 



Keypad Definitions 
5.   (left and right) arrows 

•  Select parameter to be adjusted in parameter configuration. 

•  Move marker left or right in trace operation. 

•  Turn page while in Help submenu. 

•  Use with the Shift key to zoom out or zoom in trace horizontally. 

6. Arrow 

•  Read Help menu when power .on. 

•  Cancel the current operation. 

•  Exit menu configuration. 

•  Switch between information windows. 

•  Use with the Shift key to browse up the events list. 

7. Shift 

•  Under GUI, press to return a trace to original size without any 
zoom. 

•  Activate the integration function by pressing this key together with 
other keys. 



Main Display 



Measurement Window 

Manual Measurement View 

Event Finder View 

Instrument Setup View 

Fiber Analysis View 

Measurement Window 



Event List 

Events 

•  No.: Event sequence number. 

•  Four types of events: . .begin .end; . reflection 
event; fiber end; attenuation event. 

•  Location: Distance from beginning point to 
event. 

•  Refl.: Magnitude of reflection. 

•  Ins.L.: Loss of inserted event. 

•  Attn.: Attenuation characteristic from one 
event point to the current event. 

•  Cum.L.: Cumulative loss, calculating from 
beginning point to the current event. 



A & B Markers 

A & B Markers  

A marker is used to mark and analyze a single 
event, trace section, and distance. Distance, 
attenuation, and loss at a marker or between 
markers will be displayed in marker information 

The following parameters are measured 
between marker A and B. Changing either 
marker will change the record accordingly. 

A-B: Distance between two markers. 

2Pt. Loss: Loss between two markers; power 
difference between two markers. 

2Pt. Atten: 2 points loss of unit length 



Measurement Trace Parameters 

Measurement Trace Parameters 

•  Important measurement and analysis 
parameters are displayed in the 
information window . 

•  For definitions and configurations of 
items (average time, sample distance, 
range, IOR, wavelength, and pulse 
width) as well as definitions of item 
(date, reflection threshold, non-
reflection threshold, end threshold, and 
scattering coefficient), refer to “Setup 
Configuration” later in the presentation. 



Menu Bar and Icons 



Setup Parameters 



Setup – Range Setting 

Range Setting 

•Use  and  to select an adequate range. 
Press Enter to confirm. 

Notes: 

•  “Auto” means automatic measurement. When 
this function is selected, the instrument 
automatically selects an adequate range and 
pulse width for the measurement. The process of 
measurement does not require any intervention 
by the user. 

•  “Auto” is the default setting. 



Setup – Pulsewidth 

Pulse Width Configuration 

•  The selection of pulse width affects the dynamic range 
and resolution of the measurement. With a narrow pulse 
width there will be higher resolution and smaller 
deadzone; however, the dynamic range will be 
decreased. A wide pulse width will bring higher dynamic 
range and measure comparatively longer distance, but 
resolution and deadzone will be increased. Therefore, 
users should make the choice between dynamic range 
and deadzone. . 

•  The options for pulse width will change according to the 
distance range selected. 

•  Under the parameter configuration menu use  and  
to highlight “PulseWidth.” Press Enter to select a value.   
(Press  to .exit.) 

•  “Auto” is the default setting. 

•  When the range is set to “Auto,” the pulse width 
automatically is set to “Auto.” 



Setup – Avg. Time 

Averaging Time 

•Average time will affect the SNR directly. The 
longer the average time is, the higher SNR is, 
as well as dynamic range. Therefore, when 
measuring long-distance optical fiber, a long 
average time should be selected in order to 
review events at the long-distance end. 

•  Under the parameter configuration menu use 
 .and  to highlight “Avg. Time.” Press Enter 
.to .confirm (Figure 3-12). Press .to .exit. 

•  Use  .and  to highlight the desired time. 
Press Enter to confirm. 

•  There are five levels of predefined average 
time: 15 s, 30 s, 1 min, 2 min, and 3 min. 

•  The default setting is “30 s.” 



Setup – Wavelength 

Wavelength Selection  

• Under the parameter configuration menu 
use  and  to highlight “Wavelength.” 
Press Enter to change the wavelength. 

•  Only on the 920XC 



Setup – Measure Mode 

Measure Mode 

•  There are two kinds of measurement 
mode: averaging and real-time. Under real-
time mode the 920XC will undertake real-
time measurement for the connector of 
exterior fiber and refurbish the measure 
trace. While under real-time mode, press 
Run/Stop to stop; otherwise it will measure 
continuously. Under Averaging mode the tool 
will average the data within the measure 
time, which is set by the user. When 
exceeding the set time, it will stop 
automatically and display the result. In 
general, averaging is the preferred mode. 

•  Under the parameter configuration menu 
use  and  to highlight “Meas. Mode.” 
Press Enter to select “Averaging” or “Real-
time” mode. Press  to .exit. 



Setup – VFL 

VFL Configuration 

Under the parameter configuration menu 
use  and  to highlight “VFL.” 
Depending on demand, press Enter to 
select “CW,” “1Hz,” or “Off.” Press to exit.  



Setup – Length Units 

Length Units 

•  Under the parameter configuration 
menu use  and  to highlight 
“Length Units.”  

•  Press Enter to select the desired 
units of measurement.  

•  Press  to exit. 



Setup – IOR 

Index of Refraction (IOR) Configuration 

•  Because IOR is a key factor affecting the 
speed of laser transmission in optical fiber, 
the IOR configuration has a direct impact on 
the accuracy of measurement. In general, 
the IOR parameter is provided by the optical 
fiber manufacturer, and it can be set to the 
accuracy of four digits after the decimal 
point between 1.0 .and 2.0. 

•  Under the parameter configuration menu 
use  and  to highlight “IOR.” Press 
Enter to enter a value Press  to exit. 

•  Use . and  to adjust the position of the 
highlighted area. Use  and  to change 
the digits. After setting, press Enter to 
confirm. 



Setup – Scattering Coefficient 

Scatter Coefficient Configuration 

•  Scatter coefficient determines the value of 
backscatter power. This configuration 
affects the calculation of reflection value. 

•  Under the parameter configuration menu 
use  and  to highlight “Scat. Coef.” 
Press Enter to enter a value. Press   to 
exit. 

•  Use  .and  to adjust the position of the 
highlighted area. Use  and  to change 
the digits. After setting, press  Enter to 
confirm. 



Setup – Non-Reflective Threshold 

Non-reflection Threshold Configuration 

•  This configuration has direct impact on 
the listing of insertion loss events. Only 
events ≥ to this threshold will be listed. 

•Under the parameter configuration menu 
use  and  to highlight “Nrefl. Thre.” 
Press Enter  to enter a value . Press  
to exit. 

•  Use  and  to adjust the position of the 
highlighted area. Use  .and  to change 
the digits. After setting, press Enter to 
confirm. 

•  Note: The default setting is “0.20 dB.” 



Setup – Reflective Threshold 

Reflection Threshold Configuration 

•  This configuration has direct impact on 
reflection events listing. Only reflection 
events ≥ to this threshold will be displayed 
in the events list. 

•  Under the parameter configuration menu 
use  and  to highlight “Refl. Thre.” 
Press Enter to enter a value. Press  to 
.exit. 

•  Use  .and  to adjust the position of 
the highlighted area. Use  and  to 
change the digits. After setting, press Enter 
to confirm. 

•  Note: The default setting is “–52.00 dB.” 



  
End Threshold Configuration 

•  This threshold is the end threshold of 
optical fiber. If the end threshold equals 
3.0 dB, then the first event with insertion 
loss ≥ 3 dB will be considered the end of 
the optical fiber. If the value is set to 0 
.dB, there will be no end threshold. 

•  Under the parameter configuration 
menu use  and  to highlight “End 
Thre.” Press Enter to enter a value. Press 
 to exit. 

•  Use  and  to adjust the position of 
the highlighted area. Use  .and  to 
change the digits. After setting, press 
Enter to confirm. 

•  Note: The default setting is “03.00 dB.” 

Setup – End Threshold 



Setup – Delete File 

Delete File 

•  This function deletes saved traces. 

•  Under the parameter configuration menu 
use  and  to highlight “Delete File.” 
Press Enter to enter. Press  to exit. 

•  Use  .and  to choose the files to 
delete. Press Enter to confirm. 

•  One or several files can be deleted at a 
time. Use  and  to select “Delete.” 
Press Enter, and choose “Yes” to delete or 
“No” to not delete. Choosing “Cancel” will 
exit the Delete menu. 



Setup – Time Configuration 

Time Configuration 

•  Time configuration is used to change 
system time. 

•  Under the parameter configuration 
menu use  and  to highlight “Time 
(y-m-d).” Press Enter .to change. Press 
 to exit. 

•  Use  and  to adjust the position 
of the highlighted area. Use  and  to 
change the digits. After setting, press 
Enter to confirm. 



Setup – Auto Off 

Auto Off Configuration 

•  This function conserves battery power. 
When auto off is enabled, the instrument will 
automatically power off when idle for 5 
minutes. 

•  Under the parameter configuration menu 
use  and  to highlight “Auto Off.” Press 
Enter to switch between “Off” and “On”. 
Press  to exit. 

•  Note: The default setting is “On.” 



Setup – Language 

Language Configuration 

•  There are two language options: 
English and Chinese. 

•  Under the parameter configuration 
menu use  and  to highlight “Lang./ 
.” Press Enter to .switch the language. 
Press  to exit. 



Setup – LCD Contrast Adjust 

Contrast Adjustment of LCD 

•  The contrast of the LCD can be 
adjusted. 

•  Under the parameter configuration 
menu use  and  to highlight “LCD 
Contrast.” Press Enter to adjust. Press 
 to exit. 



Setup – Color Mode 

Color Mode Setting 

•  This setting changes the color 
.scheme of the display. 

•  Under the parameter configuration 
menu use  .and  to highlight “Color 
Mode.” Press Enter to choose a 
different mode. Press  to .exit. 

•  Use  and  to highlight the 
desired color mode setting. Press 
Enter to confirm the selection. 



Setup – Default Setting 

Default Setting 

•  This function is used to set the OTDR 
parameters to factory settings. These 
parameters include: range, pulse width, 
average time, IOR, non-reflection 
threshold, reflection threshold, end 
threshold, and scatter coefficient. 

•  Under the parameter configuration menu 
use  and  to highlight “Load Default.” 
Press Enter to enter. Press  to exit. 

•Use  .and  to highlight “Yes” or “No.” 
Press Enter to confirm. 



Setup – Help 

Help 

•  The Help function 
provides access to 
the quick reference 
screen. 

•  Under the 
parameter 
configuration menu 
use  and  to 
highlight “Help.” 
Press Enter to 
display the quick 
reference screen. 
Press  to exit. 



Performing a Measurement 

Initial Splash Screen Quick Reference Screen 



Performing a Measurement 

Setup 
1. Connect the optical fiber directly to the 920XC optic output. No tools are 

required. 

2. Clean the connectors.  

3. Clean the tie-ins, making sure they are compatible (APC or UPC). 

4. Connect optical fiber to the 920XC. 

• Note: Range is set to “Auto” when auto measurement is on. 

 

Auto Trace Measurement 
Auto measurement can be used if the length of optical fiber is unknown. The 920XC 

will select an adequate range for measurement. 

For auto measurement follow these steps: 

1. Set the range to “Auto.”  

2. Press Run/Stop to start the measurement. 

3. Interface: 

4. Total: 00:30: .Measure .time, which is set by user, is 30 seconds. 

5. Passed: 00:16: Total measurement time has passed 16 seconds. 

6.  Blinking of this icon means laser is active. 

Screen while acquiring trace 

Screen while analyzing trace 



Zoom out Trace Horizontally 

To review the details of an event more closely, 
follow these steps: 

1. Under GUI use  and  to highlight       and 
then .press Enter to zoom out the trace 
horizontally. To zoom out horizontally using the 
keypad, press Shift + . 

2. .Use  or  to move the marker to the event 
point being reviewed. 

3. Refer to “Switching between Marker A/B” above 
for more information. 

Zoom in Trace Horizontally 

Under GUI  use  and  to highlight         and 
then press Enter to zoom in the trace horizontally. 
To zoom in horizontally using the keypad, press 
Shift + .. 

Zoom a Trace Horizontally 



Zoom a Trace Vertically 

Zoom out Trace Vertically 

To review the details of an event more closely, 
follow these steps: 

1. Under GUI use  and  to highlight       and 
then press Enter to zoom out the trace 
vertically. To zoom out vertically using the 
keypad, press Shift + . 

2.  Use  or  to move the marker to the event 
point being reviewed. 

3.  Refer to “Switching between Marker A/B” 
above for more information. 

Zoom in Trace Vertically 

1. Under GUI use  and  to highlight         and 
then press Enter to zoom in the trace 
vertically.  

2. To zoom in vertically using the keypad, press 
Shift + . 



Change A & B Marker 

Reviewing Marker A/B Information 

Switching between Marker A/B 

Under GUI use  and  to highlight        ,   and 
then press . Enter to switch between marker A/B. 

Use  and  to move marker A or B. 

Information between Marker A/B 

Under GUI press to  switch the information 
window to marker A/B information. 

Use  or  to change the position of marker A or 
B, and the marker A/B information will change 
accordingly in the information window. 



Re-analyze a trace 

Re-analyze a Trace 

•  If the test result at a certain threshold is not 
adequate, it can be re-analyzed using this 
function to change the threshold. This 
function can be effective while the OTDR is 
disconnected from the fiber. 

•  Under the parameter configuration menu 
edit the threshold value, and then press  
to exit the parameter configuration menu. 
Press         to re-analyze the trace. 



Save a Trace 

 
Save a Trace 

When auto or manual measurement is finished, the 
measurement trace can be saved. The contents of a 
saved trace include the trace curve and related 
information of the trace. 

1. Under GUI  use  and  to highlight , and then press 
Enter to enter 

2. Input filename: Use    and  to choose the 
alphanumeric characters one by one, and then press 
Enter to confirm. The filename can be a maximum of 
eight characters in length. 

3. Save file: Use   , and  to highlight “OK,” 
and then press Enter to save. 

4. Cancel save file: Use    and  to highlight 
“Cancel,” and then press Enter to cancel the save file 
operation. 

5. Delete alphanumeric characters: Use   , and 
 to highlight “Delete,” and then press Enter to delete 
the characters. 

6. Memory space: “118/300” means that total memory 
space is 300 files; 118 files have been saved so far. 

 



  

Browse a Saved Trace 

 
1. Under GUI  use  and  to 
highlight , and then press Enter 
to confirm. 
2. Use  and  to highlight the 
trace, and then use  and  to 
choose “Open” or “Cancel.” 
Press Enter to confirm. 
3. Memory space: “118/300” 
means that total memory space 
is 300 files; 118 files have been 
saved so far. 

 

Browse a Saved Trace 



Upload a Saved Trace 

Upload a Saved Trace 

 
Saved traces can be uploaded to a PC with the included 
Trace Viewer software. Then traces can be further 
processed on a PC. 

1. Install the software and run. Refer to Section 7. 

2. Power off the 920XC. 

3. Connect the 920XC to a PC through RS-232 or USB 
interface cable. 

4. Power on the 920XC, and upload data with the 
software. 

Notes: 
Make sure the instrument is powered off when 
connecting to a PC through RS-232 or USB data cable. 
USB operation rules must be followed while connecting 
to a PC. Proper installation of a USB driver is necessary 
before uploading the data. 
This operation cannot be applied under the GUI for 
parameter configuration, save trace, browse saved 
traces, and measuring in progress.  

 



Battery  Information 

•NiMH rechargeable 
batteries 

•8 hours continuous 
operation 

•20 hours standby 
operation 

•User changeable 
batteries 



Battery Information 

Use of Batteries 
The 920XC tools use a NiMH battery. 

Auto Off Mode 
The instrument will enter auto off mode when there is insufficient power during operation. The 
low power icon will be displayed on the LCD. 

If unused for a long time, causing insufficient power, the instrument will enter auto off mode 
several seconds after powering on in order to protect the batteries in case of excessive 
discharging. .The .internal .battery .should .be .recharged .immediately .through .the .adapter. . 

Recharging 
Perform a quick charge first, and then switch to trickle charge after the voltage reaches a 
predefined figure. Quick charge temperature is 5 °C to 45 °C (41 °F to 113 °F), and trickle charge 
temperature is 0 °F to 55 °C (32 °F to 131 °F). Battery will not be fully charged or may be 
damaged if the charging temperature is beyond the above range, which may shorten battery 
life. 

A quick charge takes 3 hours. 

Do not charge for over 8 hours. 



Battery Information 

Battery Recharge Status 

When the 920XC is powered off and powered through the AC/DC adapter, the “CHARGE” indicator on 
the interface panel  will be lit. When the battery is fully recharged, the indicator will turn off. 

When the instrument is powered on and powered through the AC/DC adapter, the internal battery is 
automatically recharged. The icons mean the following: 

When the 920XC is powered by the internal rechargeable battery, the power level of the battery is 
shown on the LCD: 

Battery is being recharged 

Battery is fully charged 

No power 

Low power 

Half power 

More than half power 

Full power 



Maintenance and Replacement of Batteries 

Maintenance and Replacement of Batteries 

 
The 920XC has two batteries: a NiMH battery to power 
the instrument and a real-time clock (RTC) battery for data 
retention. 

Note: Recharge the battery prior to use if the OTDR has 
not been used for one month. 

To replace the NiMH battery (Figure 5-1): 

1. Remove the battery compartment cover. 

2. Remove the battery and disconnect the battery 
connector. 

3. Replace the battery with the Greenlee supplied 
replacement battery. 

To replace the RTC battery (Figure 5-1): 

1. Remove the NiMH battery as above. 

2. Remove the RTC coin cell battery. 

3. Replace using a CR1220. Insert the replacement coin 
cell with the positive side facing up. 

 



Cleaning Interfaces and Connectors 

Cleaning Connectors 
Interfaces must be kept clean. Isopropyl alcohol may be used to clean the optical output. Always replace the protective dust 
caps when the unit is not being used, and keep the protective dust caps clean. In addition, flanges must be cleaned 
periodically. 

Notes: 
The diameter of optic core is 9 um, and the diameter of dust and other particulates ranges from 1/100 to 1/1/10 um. Dust 
and other particulates can cover part of the optical end and therefore degrade the performance of the instrument. 
In addition, power density may burn dust into optical fiber and induce further damage (for example, 0 dBm optic power may 
produce about 16000000 W/m*m power density in single mode fiber). If this happens, the measurement will be inaccurate 
and damage will be irreversible. 

Tools for Cleaning Interfaces and Connectors 
Optical fiber cleaner (for cleaning optical connectors) 
Optical fiber cleaning rod (for cleaning optical outputs) 
Optical fiber cleaning tissue (for cleaning optical interfaces) 
Isopropyl alcohol 
Paper tissue 
Cleaning brush 
Cleaning swabs 

Procedure for Cleaning Interfaces and Connectors 

1. Unscrew the adapter from the bulkhead. 

2. Carefully clean the bulkhead and the inside of the adapter. 

3. Screw the adapter back onto the bulkhead. 

 



Specifications 



Trace Viewer Software 



  
1. Menu 
2. Tool bar 
3. Trace display window 
(spectral line) 
4. Events list window 
(Events Table) 
5. Measurement and 
analysis parameter 
window (Parameter 
Sheet) 
6. Fiber information 
window (fiber section 
information) 
7. Fiber chain information 
window (fiber chain 
information) 
8. Status bar 

 

Trace Viewer Software GUI 



File (F) 

The functions enabled under the “File” menu include: upload 
trace file, open file, save opened file, ASCII format output, 
printing configuration, printing preview, printing, batch print 
preview, batch print, batch edit, and exit application. 

Edit (E) 

Use the Edit” menu to edit the events list: add event, delete 
event, and edit optical fiber information. Optical fiber information 
is explanatory text relating to the trace file that users type in. For 
each measurement, users can save the measurement trace with 
the 920XC. This software provides an interface for text input. For 
each trace file, users can input related information 

Window (W) 

The “Window” menu (Figure 7-5) controls the display of the sub 
windows: trace window, events table window, parameter window, 
and fiber chain information. Tile function displays sub windows 
in a layout similar to. Other submenus take the selected window 
as the current active window. 

Help (H) 

The “Help” menu displays the version of the software. 

Menu 



•  The x-axis displays the distance (km); the 
y-axis represents the backscatter power 
(dB). 

•  There are two markers, A and B; click 
either one to activate it. To move the 
marker, click and drag with the mouse 
pointer; the position information will 
change accordingly. By moving the marker, 
the horizontal distance and vertical power 
can be read manually.  

•  Zooming in and out of the trace features 
depends on the activation of a marker. The 
sloped line represents backscatter from the 
optical fiber. The peaks are reflective 
events in the fiber chain.  

•  The end of the fiber is shown by the 
sudden drop in optical power, which is 
followed by noise.  

•  The symbols at the bottom of the window 
indicate the type of event. 

Trace Window 



The events list contains the following items: 

•  No.: Sequence of events in optical fiber chain. 

•  Type: Beginning, end, reflection, and non-reflection event. 

•  Distance: Distance from OTDR to event point. 

•  Reflection Value: Value of reflection event. 

•  Insertion Loss: Vertical .decline .of .dB. 

•  Attenuation Coefficient: Value of attenuation per kilometer between current event point 
and previous event point in optical fiber chain. 

•  Cumulative Loss: dB value of loss from 0 km to current event point. 

•  Dist. Prev. (km): Distance from the previous event. 

•  Dist. End. (km): Distance from the end event. 

•  Comment: Notify other details of the event. 

Event Table 



Parameter Window 

•  The parameter window displays the 
default parameters of the currently 
displayed trace.  

•  Measurement parameters include: 
range, pulse width, average time, and 
wavelength.  

•  Analysis parameters include: IOR, 
scattering coefficient, end threshold, 
non-reflection threshold, reflection 
threshold, and sampling distance. 

Parameter Window 



Marker Information Window 

•This window displays the distance between 
marker A and B, attenuation coefficient, and 
loss information.  

•The two point loss is the difference of vertical 
power between marker A and B.  

•Two point attenuation is the two point loss of 
marker A and B divided by the horizontal 
distance between marker A and B. 

Marker Information 



Total Fiber Info 

The contents displayed in this window are date of 
measurement, length of fiber chain, loss of fiber, 
attenuation, and event number of fiber. 

Total Fiber Info 



Upload Trace Data 

•  Power off the 920XC 

•  Connect the 920XC to a PC via a serial port 
cable or USB cable.  

•  Turn the 920XC on and run the 920XC Trace 
Viewer software.  

•  Under the “File” menu, select “Upload trace 
file…”, and the “Communications Settings” 
dialog box appears.  

•  Choose a communication port (USB or RS-
232) and click “OK”.  

•  Choose the saved position of traces, and 
then start uploading data. 

Upload Trace Data 



Tool Bar 

Open file  
Save file  
Printing preview  
Printing  
Edit optical fiber information  
Zoom out trace horizontally 
Zoom in trace horizontally  
Zoom out trace vertically  
Zoom in trace vertically  
Full screen  
Analyze insertion loss (the five-point measurement to test the insertion loss)  
Analyze reflectance  
Lock marker A and B  
Display version 



ASCII Format Output 

•  The Trace Viewer software provides a 
software interface so that data can be exported 
in ASCII format and then opened and viewed by 
a third-party application. 

•  Select “ASCII format output” under the “File” 
menu.  

•  Select the information and format, and then 
press Enter to choose the path and file name. 

ASCII Format 



Edit Optical Fiber Information 

•  Select “Edit information of optical fiber” 
under the “Edit” menu to start editing 
optical fiber information. 

•  Information of optical fiber is a description 
of measurement trace displayed in the trace 
window. 

•  Users input relevant information for 
efficient management of measurement files. 
Upon completion of editing, press Enter to 
confirm. 

Edit Optical Fiber Information 



Add Event 

•  If an event on the measurement trace is 
not listed in the events list (due to 
inaccuracies caused by poor SNR or 
inadequate parameter configuration), use 
the “add event” function to manually add 
this event into the events list.  

•  Click the events list window, and select 
“Add event” under the “Editing” menu. 

•  Choose the type of event from the pull-
down menu, enter the event features, and 
then press Enter to add the event to the 
events list. 

Add Event 



Modify Event 

•  Use the “revise event” function to manually 
revise features of an event (due to inaccuracies 
caused by poor SNR or inadequate parameter 
configuration).  

•  Select the event to be revised in the events list 
window, and select “Revise event”.   

•  After modifying the event feature(s), press Enter 
to confirm the changes. The software will 
automatically refresh the event sequence. 

•Events can also be revised by clicking on the 
event to access a pop-up menu. 

Modify Event 



Delete Event 

•  Use the “delete event” function to manually delete a trace from the events 
list when it appears in error (due to inaccuracies caused by poor SNR or 
inadequate parameter configuration).  

•  Highlight the event to be deleted, and then select “Delete event” under the 
“Editing” menu. 

•  Events can also be deleted by clicking on the event to access a pop-up 
menu. 

Delete Event 



Batch Edit 

Batch Edit 

•  The 920XC Trace Viewer software 
has a batch-edit function that allows 
users to edit the trace information of 
several trace files in the same folder 
at one time.  

•  Select “Batch Edit” under the 
“File” menu. 



Printing 

Printing Options 

•  Select “Printing options…” under the “File” 
menu to select the contents to be printed. 

Printing Setup 

Select “Printing setup” under the “File” menu to 
select the printer, paper size, and printing 
orientation. 



Batch Print 

•  The 920XC Trace Viewer software has a 
batch-print function that allows users to print 
several trace files in the same folder at one 
time.  

•  Select “Batch Print” under the “File” menu. 

Batch Print 
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Why is Greenlee launching the 920XC Handheld OTDR? 
Telecommunications service providers are installing fiber optic networks to deliver high 
bandwidth service to their customer base.  Telecommunications providers require an OTDR 
to perform cable acceptance testing and fault location on fiber optic networks.  There are two 
main types of networks being deployed by the telecom service provider: 

♦FTTN – fiber to the node in which a fiber is run from the central office to node 
that service the neighborhood of business.   

♦FTTH – Fiber to the Home were a fiber is run directly to the home.  

 

Product Positioning Statement 
We are proud to announce the 920XC series of handheld OTDR’s.  The 920XC product 
launch coincides with the rapid expansion of telecom service provider’s fiber optic build out 
of the last mile high bandwidth network.  The 920XC is the ideal instrument for the OSP 
telecom technician to use for cable acceptance testing and fault locating. 

Why the 920XC?  



What is an OTDR?  

The Optical Time Domain Reflectometer (OTDR) is an instrument that uses the inherent backscattering 
properties of an optical fiber to detect faults and categorize its condition. The OTDR sends high-power 
pulses of laser light down the fiber and captures the light that is reflected back (much like a radar system). 
By measuring the timing and power levels of the return pulses, the instrument correlates the reflected 
information with physical locations along the fiber and displays a “trace” that shows optical power versus 
distance. Attenuation of the fiber is displayed as the slope of the trace. Interruptions such as splices, 
connectors, bends, breaks or flaws in the fiber appear as transitions (“events”) that represent their nature 
and location. 

Display Processor

Detector

Laser

Coupler

Fiber 
under test

Probe 
pulse

End of 
fiber

Rayleigh 
backscatter

Fresnel 
reflection



What is cable acceptance testing? 
When a fiber is installed by a telecom service provider they are required (typically by the service 
providers method and practices (procedure) to perform OTDR testing.  The OTDR cable 
acceptance test documents the loss of the fiber span, the length of the cable and the loss of any 
splices that may be on the fiber cable. 

 

What is fault locating? 
As fiber proliferates into the last mile of the service provider’s fiber optic network, fiber optic cable 
faults will increase.  Fault locating is using the OTDR to find a break in the fiber optic cable.  The 
920XC easily accomplishes this task through the Auto setup mode.  The user simply has to press 
the START/STOP key and reads the distance to the fiber break.  

 

What is cable acceptance testing and fault locating?  



Features 
•  Easy to Use/Compact Handheld Design 

•  Automated Measurement/Analysis/File Save 

•  38dB Dynamic Range 

•  1.5 meter event deadzone 

•  Large color LCD display 

•  Measure length and defects of coiled fiber 

•  RS-232 and USB interface 

•  Store 1000 measurement results 

•  NiMH battery for 8 hours continuous use 

•  Internal VFL (650nm) 

920XC Feature Overview   



920XC Handheld OTDR 

Protective 
Rubber Boot 

Sealed 
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Color LCD with 
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USB and RS-232 port 



Specifications 



What is the 920XC product configuration? 
The 920XC has four base models to choose from: 

 

 

Base Model  Description  

920XC-30F  1310/1550/1625nm OTDR   

920XC-30P 1310/1490/1550nm    

920XC-20C 1310/1550nm OTDR   

920XC-20M 8501300nm Multimode OTDR   

 

Product Configurations  



Optical Interfaces 

OTDR and VFL Interface 

•PC or APC polish 

•Ceramic alignment sleeve 

•Removable adapter for easy 
cleaning 

•Protective dust caps 

•Connector adapters available 

•FC 

•ST 

•SC 
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